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Using this 
template 

The standard headings and tables in this template should be modified to meet the 
requirements of each Initial Assessment.  The sites may have diverse issues and 
constraints and problems and the standard template is therefore just a guide on 
typical requirements but flexibility is allowed to amend/ add headings as required 

 

 Hidden 
guidance 

The template contains various pieces of guidance covering content, use of tables 
etc.  The guidance is shown in blue text and can be turned ‘on’ to assist in the 
writing stages or ‘hidden’ for viewing or when printing the document.  You can 
switch between ‘hidden’ and ‘on’ and back to ‘hidden’ at any time. 

To show/hide the guidance click on the ¶ icon on the MS Word toolbar.  

If the hidden text does not disappear off the screen when the ¶ icon is clicked, go 
to:  Tools>Options>View Tab and uncheck the ‘Hidden text’ box.   

It is advisable to work with the hidden text turned on, as this helps to format new 
text and to avoid deleting the hidden text itself. 

 

Auto-
updating of 
contents 
page 

The contents page will update to reflect changed information in the main text and 
tables.  To update right click on the relevant area of the contents page, to highlight 
it, and select ‘Update Field” to access the update option. 

To enable these updating features to be created, the document contains specific 
text types and “fields”.  These are Headings 1, 2, 3 & 4; fields in the table labels 
and in the appendix labels.  When editing the document, take care to maintain 
these aspects. 

 

Inserting new 
headings 

To insert new headings in the main text go to: Format>Styles and Formatting to 
open the styles box. Insert the new headings, highlight it and click on the 
appropriate Heading level in the ‘Pick formatting to apply’ box.  Paragraph text 
can be inserted and formatted in a similar way. 

  

 

Inserting new 
tables 

Table labels should be added by Insert>Reference>Caption and selecting ‘Table’ 
from the drop down ‘Label’ box.  This will insert the Table title with the correct 
number and the caption can be typed in after the label.  Tables can then be cross 
referenced from the text by Insert>Reference>Cross Reference and selecting the 
appropriate reference type and caption from the drop down box and list. 
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Numbering 
paragraphs 

All paragraphs should be numbered sequentially as sub-sets of the section 
number. Prompts for paragraph numbering are provided as ‘Start writing here’ 
after which pressing <return> will automatically provide the next paragraph 
number.  
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1.1  Introduction and background 

Working in partnership with the City of Bradford Metropolitan District Council, 15 locations within 
Bradford were identified to have been significantly affected by the 2015 Christmas Floods. These 
locations were subsequently grouped into five main catchment areas to be put forward for initial 
assessments to be undertaken by CH2M: 

 

•        Keighley & Stockbridge 

•        Bingley & Airedale 

•        Baildon & Shipley 

•        Esholt & Apperley Bridge 

•        Silsden Beck 

The inputs for the FCRM Partnership Funding Calculator were obtained through consultation with 
Bradford Metropolitan District Council and highlighting the properties likely to benefit from a 
preferred potential scheme at each study site. For the study area of Ash Grove and Wagon Lane, 
this was achieved through assessing modelled flood extents from the River Aire Modelling Study 
(Atkins, 2004) and draft 2015 Christmas flood outlines (April 2016) composed by the Environment 
Agency. 

 

The objective of this initial assessment is to assess the potential for a scheme to alleviate flood risk 
within the Wagon Lane and Ash Grove areas. If a particular option is found to be economically 
viable under this high level assessment, there is scope for it to be carried forward to an Outline 
Business Case (OBC). 

 

1.1.1 Description of Location 

Bingley is a small town in the Metropolitan Borough of the City of Bradford, in West Yorkshire. It is 
situated between the River Aire and the Leeds and Liverpool Canal and has an estimated 
population of approximately 18,300 people. 

The study area of Wagon Lane and Ash Grove is situated in the south-east of the town along the 
River Aire. Both streets lie beyond the left bank of the river, immediately downstream of the 
Bradford Road Bridge. Further downstream the river meanders and flows under the A650 road 
bridge.  

According to the Index of Multiple Deprivation (IMD) this area is amongst the 30% least deprived 
neighbourhoods in the country. 

A location plan is shown below in Figure 1 and the study area can be found in Appendix G. The 
key feature affecting local river hydraulics is Bradford Road Bridge, which will act as a flow 
constriction during extreme events. Additionally, the A650 road bridge immediately downstream of 
the site poses a blockage risk - the Environment Agency commissioned emergency shoal 
clearance works (May 2016) to remove three shoal banks here which accreted as a result of the 
December 2015 flood. 

The sections of main river are shown below in Figure 2. 
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Figure 1: Location Plan 

 

Figure 2: Main Rivers 

 

1.1.2 Description of Watercourses and Geology 

The River Aire originates in the Pennine hills near Malham in the Yorkshire Dales, flowing in a 
south easterly direction until it reaches Castleford, where the river is joined by the River Calder and 
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turns eastward toward Airmyn. Here, the River Aire meets the River Ouse approximately 148 
kilometres from its source.  

The River Aire banks have been considerably modified over time for flood risk management 
purposes. Flood embankments have been built up along much of the channel and there are several 
controlled washland (floodplain) areas along its length both upstream and downstream of Leeds. 
These act as both controlled and uncontrolled washlands and significantly attenuate peak flows 
along the river. 

The study area lies in the ‘Upper Aire’ reach of this large watercourse, which is defined as the reach 
from upstream of Gargrave Bridge to Leeds Station Weir. The area lies in the high moorland area 
in the Upper reaches of the catchment, with an average gradient of approximately 1 in 640 (average 
gradient between Stockbridge monitoring station and Leeds Station Weir).   

There are no formal flood defences present within the study area.   

The geology of the study area is characterised Millstone Grits, shales, grits and coal seams. 

1.1.3 History of Flooding 

Major flooding in the catchment occurred in 1946, 1967, 1980, June 2000, October/November 
2000, February 2002 and August 2002.  

Anecdotal evidence provided by local residents relating to the December 2015 event suggests that 
prior to the River Aire overtopping its left bank downstream of Bradford Bridge, flooding initiated 
from seepage through the ground due to the rising water table. 

No further information on site specific flooding was found during the course of this assessment.  

1.1.4 Summary of Modelling Analysis 

In 2001 Atkins were commissioned to deliver Phase 1 of the River Aire Modelling Study. This further 
lead onto the development of a robust calibrated model, which was then used to undertake a series 
of design runs. 

The River Aire model reach was defined from Gargrave at its upstream extent, to its confluence 
with the River Ouse downstream of Airmyn. In order to accommodate this long stretch, the River 
Aire was subdivided into the following three reaches and modelled accordingly: 

 “Upper Aire” - from upstream of Gargrave Bridge to Leeds Station Weir (FDMS 
reaches 16-29) 

 “Lower Aire” - from Leeds Station Weir to Fairburn Ings (FDMS reaches 12-15) 
and the Lower Calder from Stanley Ferry to its confluence with the Aire (FDMS 
reaches 1-3) 

 “Tidal Aire” - from Fairburn Ings to the River Ouse at Airmyn (FDMS reaches 1- 
11) 

This study area falls within the ’Upper Aire’ reach. The final three models combined to form a 
catchment wide one-dimensional hydrodynamic (ISIS) model which was deemed to effectively 
capture the flow attenuation within the catchment. The only fluvial design event to be assessed in 
this study was the 1 in 100 year (1% AEP) event. The study was completed in autumn 2004. 

Following on from this, the Upper Aire Flood Risk Management Strategy (Atkins, 2006) was 
completed, which looked at developing a strategic plan for future flood risk management on main 
rivers in the Aire catchment, between Bell Busk and Fleet Weir. The study area of this initial 
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assessment was covered by this update, and fluvial flood outlines derived from this study have 
been used to inform flood risk in this initial assessment.  

The existing hydraulic model has allowed for climate change up to the year 2105 with a 30% 
increase to the hydrological inflow. However the guidance for climate change analysis has been 
updated since the Upper Aire Modelling Study and therefore these results are likely to be 
superseded by the new guidance. Climate change modelled flood outlines were not considered in 
this initial assessment with analysis using present day outlines to assign flood risk bands. The 
model has not been calibrated since the work undertaken in 2002 to 2004 and should be updated 
to include recent events if any scheme progresses to OBC stage. 

Downstream of the study area there are three weirs which influence water levels at the site. 
Detailed modelling work on the three weirs is currently being undertaken by the EA National Flood 
Modelling team. At this stage an initial review indicates there may be limited benefit from removing 
or lowering the weirs. 

1.1.5 Drivers, Constraints, Opportunities 

Bingley falls under the River Aire Catchment Flood Management Plan1 (CFMP), and is covered by 
sub-area 3 Worth and Aire. The designated policy for residential areas at risk is Policy Option 5: 
areas of moderate to high flood risk where we can generally take further action to reduce flood risk. 
This policy will tend to be applied to those areas where the case for further action to reduce flood 
risk is most compelling. The CFMP vision is to improve the co-ordination between the multiple 
organizations that manage the various sources of risk. 

The following drivers, constraints and opportunities have been identified within the study area.  

Political Drivers  Exist?  Summary Description 

Catchment Flood Management Plan Yes River Aire CFMP 2010 

Catchment Flood Management Policy Yes 
Policy 5: Areas of moderate to high flood risk 
where we can generally take further action 
to reduce flood risk 

Economic Drivers   Exist?  Summary Description 

Enable Development Yes 
There is potential development at this site 
but is dependent on flood risk and the 
outcome of this options analysis. 

Technological Drivers  Exist?  Summary Description 

Improved Public Safety Yes Via reduced flood risk.  

Environmental Constraints  Exist?  Summary Description 

World Heritage Site Yes 

World Heritage Site lies approximately 500m 
east of the Benefits area. A full impact 
assessment should be conducted if the 
scheme progresses to Outline Business Case. 

 

 

 

                                                

 
1 https://www.gov.uk/government/publications/river-aire-catchment-flood-management-plan 

https://www.gov.uk/government/publications/river-aire-catchment-flood-management-plan


IMNE790567-CH2-FEV-AG0-AS-C-0001 Initial Assessment report Page 7 

1.2 Problem and objectives 

1.2.1 Problem 

Due to a lack of formal flood defences the area adjacent to Wagon Lane and Ash Grove suffered 
extensive flooding during the December 2015 event. This flooding is believed to be as a result of 
the River Aire overtopping its left bank both upstream and downstream of Bradford Road Bridge. 
Evidence from residents along Ash Grove indicates that water initially began to seep up through 
the ground as the river levels rose (suggesting a link between ground water levels and river levels). 
Subsequently, as the river levels increased, the river began overtopping its left bank upstream and 
downstream of Bradford Road Bridge, and therefore inundating the study area. 

The bridge on Bradford Road acts as a throttle, posing a flow constriction risk during high flows. 
During the December 2015 event flow backed up at this structure, increasing water levels 
upstream, which in turn overtopped the left bank and flooded the study area from the west. 

This second overland flow pathway conveyed eastwards across Bradford Road and over the study 
area, returning to the river via the grounds of the Bradford and Bingley Sports Club. The standard 
of service provided by the natural river banks within the study area has been estimated as 1 in 25 
year (4% AEP). 

Bradford Road was also inundated south of the river from South of Beckfoot Lane to Bingley 
Fencing where a dip in the road occurs and frequently floods. The most likely cause of this flooding 
is judged to be surface water. Appendix J, shows a surface water flood map provided by BMDC. 

Bradford Bridge itself was not inundated or overtopped and remained dry for the duration of the 
December 2015 flood event.   

In addition to flood risk beyond the left bank of the River Aire, modelled flood outlines used to inform 
this initial assessment also highlight potential flood risk to the properties behind the right bank 
between Bradford Road and the river. 

There is evidence to suggest that gravel accretion downstream of the site presents an increased 
flood risk to upstream areas. Immediately upstream of the A650, the Environment Agency identified 
three shoal locations for clearance post Boxing Day 2015 event (see Appendix H).  

Further photos and a video of the flood event are in Appendix I. 
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1.2.2 Objectives 

The objectives of this initial assessment are to assess the current condition of the site and evaluate 
the possible options for reducing flood risk within the study area.  

The purpose of this report is to undertake a high level appraisal and, where applicable, provide a 
preliminary business case for further development and a more detailed future appraisal. The report 
aims to achieve the following: 

 Confirm the need for a project; 

 Identify the issues and Political, Environmental, Societal, Technological, 
Legislative and Economic (PESTLE) drivers and opportunities related to the 
need; 

 Identify the options to address the project needs and problems; 

 Demonstrate that viable options exist based upon the available information; 

 Provide sufficient information to allow the packaging and optimisation of 
packages of future appraisal, design and construction packages; 

 Provide sufficient information for the appraisal scope to be prepared; 

 Make an assessment on the deliverability of the project; 

 Provide a basis/starting point for discussion with communities and partner 
organisations for use in the development of potential schemes and 
negotiations regarding funding contributions. 

 

1.3 Benefits 

In this area the primary benefit associated with a reduction in flood risk would be the reduction in 
economic damages to the affected properties. Potential options could also reduce disruption to 
local transport, businesses, schools and other infrastructure. 

The properties at risk include residential, commercial and public buildings. 

Social benefits relate primarily to a reduction in stress, health effects (including risk to life) and loss 
of memorabilia for those at risk. 

An appraisal period of 100 years is assumed, over which the current Standard of Protection of 
existing assets is expected to decrease as a result of climate change. 

The property figures in Table 1-1 have been estimated based on the modelled flood outlines from 
the Upper Aire Flood Risk Management Strategy (see Section 1.1.4). 
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Table 1-1 Number of Properties at Risk (based on Dec 2015 flood) 

Property Type Flood Risk 
Number of 
Properties 

Residential  

≥1 in 25 year (4% AEP) 

(Very Significant Risk) 
56 

<1 in 25 year (4% AEP) 

≥1 in 75 year (1.33% AEP) 
(Significant Risk) 

4 

<1 in 75 year (1.33% AEP)  

≥1 in 200 year (0.5% AEP) 

(Moderate Risk) 

4 

Non-Residential 

≥1 in 25 year (4% AEP) 

(Very Significant Risk) 
3 

<1 in 25 year (4% AEP) 

≥1 in 75 year (1.33% AEP) 

(Significant Risk) 

1 

<1 in 75 year (1.33% AEP) 

≥1 in 200 year (0.5% AEP) 

(Moderate Risk) 

0 

Detail of the methodology used for assessing the benefits of each option is detailed in Appendix C. 

 

1.4 Options 

A long list of options has been compiled for the study area and is summarised in the table on the 
following page. The table shows the range of options considered and the reasoning for or against 
them being taken forward to the shortlist of options to be assessed. 
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Table 1-2 Long List of Options 

Category Long List Option Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study 
Reference 

Do nothing Do nothing All operational and 
maintenance activities cease 

Yes Required to support development of 
business case and benefit cost 
ratios. 

Do minimum Do Minimum Continue with current 
operational and maintenance 
activities.  

Yes Represents current approach to 
asset maintenance and repair. 
Minor works to retain necessary 
performance. 

Non-structural 
(by EA) 

Improved flood warning Enhanced flood warning to 
allow residents to prepare 
plus appropriate 
implementation of flood action 
plans 

No Not funded via the capital 
programme.  

A Flood warning system is already 
in place for the River Aire at Ash 
Grove and Wagon Lane.   
Improving the current system would 
require further modelling which is 
beyond the scope of this study and 
therefore this option is not 
considered at this stage. 

Non-structural 
(by EA) 

Flood action plans Improved direction of 
reactionary flood defence 
measure (fire crews, 
temporary pumps, etc.) 

No This option is not funded via the 
capital programme, however it is 
recommended that community 
members are actively involved in 
setting up a Flood Action Plan if one 
is not already in place.  

A flood action plan would be 
beneficial to reduce reaction times 
as residents reported only receiving 
sand bags after Boxing Day event. 

The study area is already within a 
Flood Warning and Flood Alert area 
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operated by the Environment 
Agency. 

However, this is considered to be 
outside of the scope of this appraisal 
and has not been undertaken at this 
stage. 

Property level 
protection 

Property level protection Protection to individual 
properties (e.g. via air brick 
covers, door guards etc).  

Yes PLP is assumed to be viable for all 
ground floor residential properties in 
the very significant risk band. 
However, the depth of flooding at 
these properties would have to be 
analysed at the next stage, as PLP 
is only suitable where the flood 
depth is less than 500mm and 
duration less than 3 days. PLP could 
be offered as an option in 
combination with other options. 

Operational 
(by Others) 

Improve 
operation/design  

Improve operation/design of 
assets not owned by the EA 

No No third party assets known to 
significantly contribute to flood risk 
in the study area. 

Urban drainage 

 

 

Improve urban drainage. Improved surface water 
drainage system. 

No – But further 
analysis are 
needed 

Evidence provided by BMDC shows 
that flooding in the vicinity of 
Bradford Road to the south of the 
River Aire may be attributed to 
surface water (see Appendix J). 
More detailed information is 
required to gain a better 
understanding of all flood sources. 

Structural Earth bunds Bank raising Yes Raised flood embankments to 
prevent or reduce overtopping of 
riverbanks. Where there is 
insufficient space for an 
embankment footprint, a sheet piled 
wall will be considered. 
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 Structural Flood walls Flood walls Yes Use of flood wall to prevent 
overtopping of riverbanks and to 
protect properties at risk.  

Structural Conveyance Channel deepening or 
widening, including routine 
dredging. 

No River channel is well defined and of 
considerable width already. There 
was no clear evidence of gravel 
accretion at either Bradford Road 
Bridge or the A650 Bridge 
downstream from the site visit.  

Structural Conveyance River restoration and/or pinch 
point improvements (bridges, 
culverts and weirs) 

No Both Bradford Road and the A650 
bridges are large structures to which 
no adjustments will be considered 
for this study due to cost far 
outweighing benefit.  

This could be looked at in the future 
under a different project, should the 
council ever consider structure 
works/replacement.  

Flood storage area  Online Use of active structures and 
re-profiling to store water 
online.  

No There is not sufficient space to 
create FSAs of the required size in 
or near the study area. 

A large scale FSA system was 
considered in the Upper Aire SFRA 
that would have a large impact 
beyond the study area, and is 
considered to be outside of the 
scope of this appraisal. 

Flood storage area Offline Gravity or pumping to offline 
storage area 

No As above, there is not sufficient 
space to create FSAs of the required 
size in or near the study area. 
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1.4.1 Shortlisted Options Description 

The options below were chosen to be taken forward for assessment in the initial assessment 

 

Do Nothing  

The Do Nothing option is defined as taking no action whatsoever; under this option all management 
activities would cease, including maintenance and repair work to existing assets.  

There could be some advantages of this option in the form of habitat creation due to wetting of dry 
areas and naturalisation of channel, however, this is also likely to increase the risk to wildlife and 
people. 

The Do Nothing option is not to be taken forward as a viable option as it results in an unacceptable 
increase in flood risk to people and property due to failure and deterioration of assets and blockages 
to the channel. 

For appraisal purposes the Do Nothing option is used as the baseline against which all other 
options are measured against.     

Do Minimum 

The Do Minimum option is defined as the minimum level of action or intervention necessary to 
sustain the standard of service (SOS) presently offered throughout the study area. It will form the 
appraisal baseline.  

There are no existing defence assets that lie in the study area therefore this option is limited to 
maintenance for the channel itself and Bradford Road Bridge. However given that three locations 
along the River Aire immediately downstream of the study area were identified for shoal clearance 
post Boxing Day 2015 event, it suggests that gravel deposition within the river channel can 
contribute to flood risk upstream (see Appendix H).  

The advantage of Do Minimum is that it sustains current standard of service within the study area 
and there are no increase in costs associated with this option. It ensures that the risk of blockages 
and a reduction in channel conveyance capacity are reduced.  

The disadvantages of Do Minimum is that the current maintenance regime is not believed to 
significantly reduce the flood risk to people and properties in the study area. It does not account for 
the increase in flood risk due to climate change. A further solution would therefore be required in 
order to reduce the effect of higher frequency flood events.   

There are no indicators to suggest that this option is non-viable or undeliverable.    

Option 1 – Property level protection 

This option considers property level protection (PLP) to those properties at greatest risk of flooding. 
PLP can take the form of barriers in doorways, non-return valves fitted to drains, and airbrick/vent 
covers. Properties can also be made more flood resilient, using waterproof plaster, solid concrete 
floors or tiled floor coverings in order to reduce the amount of time and money needed to recover 
from a flood event. PLP is generally used as an option for properties that experience less than 
500mm of flooding. 

Advantages of this option include the fact that defences have minimal visual and land impact, and 
do not remove any of the flood plain area. PLP will protect against surface water as well as fluvial 
flooding.  

Disadvantages of this option include the requirement for residents to receive sufficient alert and for 
them to be available and trained in deploying PLP measures. Furthermore, PLP does not provide 
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any wider environmental benefits and does not prevent the flooding of areas surrounding the 
property. PLP is only deemed effective for return periods of up to a 1 in 50 (2% AEP) chance of 
occurrence in any given year and where flooding is less than 500mm deep. The efficacy of PLP 
reduces with long duration floods due to seepage. 

 

Option 2 – Combination of earth embankments and sheet piled wall 

This option is to construct flood defences around the low-lying properties on Ash Grove and Wagon 
Lane at risk from flooding. The proposed scheme would consist of earth embankments and a sheet 
piled floodwall (defence schematic shown in Figure 3).  

The Standard of Protection offered by the scheme will be 1% AEP plus climate change. The 
alignment of the bunds and their dimensions have been approximated for the purpose of this initial 
assessment, with final alignment and dimensions to be decided upon should the option progress 
to OBC stage. The costs are based on an embankment with a total length of 1,075m, 2m height 
and 14m width at the base (assuming a 1 in 3 side slope). Additionally, clay cut-offs will need to be 
incorporated into the final design to block seepage paths, like those which occurred during the Dec 
2015 event.  

A sheet piled wall has also been considered to protect the properties lying beyond the right bank 
downstream of Bradford Road Bridge. A sheet piled wall will cut off any flood risk from seepage 
(provided that the piles are of sufficient length to intercept the seepage path). For the purpose of 
this high level assessment the wall dimensions considered are 4m high and 345m long.  

 

Figure 3: Alignment of the assets. Embankments showed in brown, sheet piled wall showed 
with the blue line. 

If this option is taken forward, alignment and dimensions will need to be optimised in order to 
consider all potential sources of flooding and to meet the required standard of protection. This 
option proposes a permanent structure and does not require any operational input.  
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Further modelling will be required in order to assess the impact of removal of floodplain on 
communities further downstream due to the construction of these flood defences. Compensatory 
floodplain storage may be required, adding to the costs of the scheme. The modelling work shall 
ensure that the compensatory storage is hydraulically linked to the floodplain lost, otherwise the 
benefits from it may not be fully realised. With this option, impact on groundwater and surface water 
flooding will also need to be investigated. 

A higher bund would not be a viable option, as the bunds will have side slopes of 1 in 3, and 
therefore for each increase in height of 1m the footprint increases by 6m which would result in large 
footprint for high bunds. Its design should be made to fit visually in to the surrounding area. 
Construction of the bund has the potential to cause temporary disruption to roads and properties.  

 

Option 3 – Concrete floodwalls with cutoff  

This option retains the alignment of option 2, but the flood defences will consist entirely of reinforced 
concrete walls. For a standard of protection of 1 in 100 years (1% AEP) plus climate change, the 
height of the wall above the ground level has been estimated at 2m. The height of the defence will 
need to be refined following detailed modelling information should the option be carried forward to 
OBC stage. 

Piled cutoff is required, especially where the wall is built along the riverbank, to reduce seepage 
under the wall and to help to provide resistance against sliding failure. 

The main advantage of the reinforced concrete wall, is that it will require a smaller footprint than an 
embankment. Some of the properties at risk are located along the river bank where space for 
construction is limited. The smaller footprint of floodwalls will also reduce the amount of 
compensatory floodplain creation needed when compared against bunds. 

Cladding of brick may be required for the stretches of wall which are more visually exposed (not 
hidden behind property gardens) to make the scheme visually attractive to the surrounding area 
(for example along the Bradford and Bingley Sports Club perimeter).    

 

1.4.2 Costs of options 

The costs for the options were calculated using the Environment Agency’s Project Cost Tool and 
Long Term Costing Workbook.  

It is assumed that a major replacement of assets will be required at some point during the appraisal 
period after the initial construction phase. The timing of these replacements is based on the 
Environment Agency’s Asset Deterioration Guidance (2013), an appraisal period of 100 years has 
been used and the assumptions are outlined in Appendix B. Table 1.1 shows the initial costs for 
the options, it is assumed that replacement of the assets will be required when the assets reach 
Condition Grade 5 (CG5):  

 Option 1 - 20 years (PLP) 

 Option 2 - 60 years  

 Option 3 - 90 years 

 

 

Table 1-3 Project costs (£k) 

Item Option 1 Option 2 Option 3 

Construction Base 
Cost   

428.13 2600.70 3849.24 
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Item Option 1 Option 2 Option 3 

Environment Agency 
staff  

65.50 184.65 273.30 

Consultant fees 
(appraisal) 

23.98 127.43 188.61 

Consultant fees 
(Design) 

82.63 351.09 519.65 

Consultant fees 
(construction) 

21.41 148.24 219.41 

Surveys (Ground 
investigation) 

3.85 85.82 127.02 

Surveys 
(Archaeological) 

1.71 13.00 19.25 

Land purchase  0.29 13.00 19.25 

Sub-total  627.50 3523.94 5215.72 

Optimism Bias (44%) 276.10 1550.53 2294.92 

TOTAL 903.60 5074.48 7510.64 

 

Further details can be found in Appendix B. 
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1.5 Initial environmental assessment 

The study area lies in the south eastern part of the town of Bingley. Any defence scheme 
considered in this initial assessment will need to work towards having a minimal impact on the 
surrounding environment especially due to its close proximity to properties. Possible environmental 
impacts of all options considered in this study are listed below.  

 

Table 1-4 Key environmental impacts, mitigation and opportunities 

Key positive impacts Key negative impacts 
Mitigation/ enhancement 
opportunity 

Option 1 

 

- Low aesthetic effect 

 

- Low risk of pollution 
incidents and disruption to 
area during construction 

 

 

 

 

Option 2 

 

- Reduced risk of fluvial 
flooding 

 

- Low aesthetic effect 

 

 

- Construction work takes place 
alongside watercourse. Risk of 
pollution incidents and disruption 
to area during construction 

 

- Possible temporary increase to 
noise/vibration levels during 
construction 

 

- Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance 

 

- Early engagement with residents 
recommended to promote 
awareness and minimise negative 
impacts of construction phase 

 

Option 3  

 

- Reduced risk of fluvial 
flooding 

 

 

- Construction work takes place 
alongside watercourse. Risk of 
pollution incidents and disruption 
to area during construction 

 

- Possible temporary increase to 
noise/vibration levels during 
construction 

 

- Visual Impact on area 

 

 

- Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance 

 

- Early engagement with residents 
recommended to promote 
awareness and minimise negative 
impacts of construction phase 

 

 

A calculation of the total carbon emissions of each option has been done and is reported in 
Appendix F. 

 

1.6 Consultation 

The options in this appraisal were developed in consultation with the Environment Agency. No 
public consultations were held at this stage as the work is a high-level assessment of potential 
options. Stakeholder engagement will take place at subsequent stages of the project. 
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If this project is taken forward for further appraisal it is recommended that consultation is focused 
on, but not limited to, the following: 

 Statutory Stakeholders 

 Residents in the area at risk 

 Riparian landowners, especially owners of riverside walls acting as formal/informal 
defences. 

 

1.7 Economic summary and preliminary preferred option 

Table 1-5 summarises the economic assessment carried out for all options. The calculations for 
PV benefits are shown in Appendix D. These benefit values are estimates based on the 
methodology detailed in Appendix C. There is significant uncertainty in these estimates and if 
further appraisal is carried out the benefits for the preferred option should be more accurately 
assessed through detailed hydraulic modelling. 

Modelled flood outlines produced for the Upper Aire Flood Risk Management Strategy were used 
to inform these benefit calculations. A count of properties falling within each flood outline was 
carried out using the National Receptor Dataset (NRD), and all the properties in the study area, 
were classed into the Very Significant, Significant and Moderate risk bands (see Table 1-1). Details 
of the methodology used is presented in Appendix C. 

Table 1-5 Benefit-cost assessment (£m) 

 PV 
costs 

(£m) 

PV 
benefits 

(£m) 

Av. BCR 
Incr’ 
BCR 

Option for 
iBCR calc  

Comments 

Do 
Nothing 

   
 

 
 

Do 
Minimum 

0.04 0.72 18.51    

Option 1 1.87 2.97 1.59 1.23 Do Minimum 
All use Do Minimum as 

base case 
Option 2 5.76 5.20 0.90 0.78 Do minimum 

Option 3 7.70 5.66 0.70 0.61 Do minimum 

Option 1 is the recommended option to be carry forward for further appraisal. Option 1 scores an 
incremental BCR >1 and would succeed in reducing flood risk and protecting properties for lower 
order extreme events. Option 1’s BCR>1 suggests that it can also be economically viable.  

With the uncertainties in the evaluation of costs and benefits, and the value of the BCR value close 
to one, Option 2 could also be considered for further analysis. Informed by more detailed hydraulic 
modelling mapping overland flow pathways and flood depth, Option 2’s benefits may prove to be 
greater than this high level assessment suggests. The total benefits achievable for Options 2 and 
3 differ slightly due to defence type design life according to the Asset Deterioration Guidance 
Report (SC060078). 

Note that in Table 1-6 the values differ slightly as they are total benefits and costs over the initial 
benefit period rather than the 100 year appraisal period as is the case for Table 1-5. When 
considering the benefit period alone, Option 1 scores an increased BCR of 2.35. 

 

Table 1-6 Benefit-cost ratios and outcome measures  
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Contributions to outcome measures  Option 1 Option 2 Option 3 

OM1 – Economic Benefit:     

    Benefit period used for Partnership 
Funding calcs 

20 60 90 

    PV Benefits (£m) 2.00 4.67 5.32 

    PV Costs (£m) 0.92 5.11 7.55 

    Benefit/Cost ratio 2.35 0.91 0.70 

OM2 – No. of households moved out of any 

flood probability category to a lower category 
60 60 60 

OM2b – No. of households for which the 
probability of flooding or coastal erosion is 
reduced from the very significant or 
significant category to the moderate or low 
category 

0 60 60 

OM2c – No. of households in the 20% most 
deprived areas moved from the very 
significant or significant flood probability 
category to the moderate or low category  

0 0 0 

OM4a – Hectares of water dependent habitat 
created or improved to help meet the 
objectives of the Water Framework Directive 

0 0 0 

OM4b – Hectares of intertidal habitat created 
to help meet the objectives of the Water 
Framework Directive for areas protected 
under the EU Habitats/Birds Directive  

0 0 0 

OM4c – Kilometres of rivers protected under 
the EU Habitats/Birds Directive improved to 
help meet the objectives of the Water 
Framework Directive 

0 0 0 

Partnership Funding (PF) Score  23% 10% 8% 

Contributions required for a PF score of 
100% (£m) 

0.71 4.58 6.92 

Contributions required for a PF score of 
120% (£m) 

0.74 4.67 7.02 

 

As stated in the Multi-Coloured Handbook 2016 (page 4-13), the benefits referred to for option 1 
(PLP) are factored by 0.75 to take account of the risk of incorrect use. 

 

1.7.1 Funding and contributions 

A funding analysis tool was used to identify potential direct and indirect beneficiaries of the scheme. 
This is included in Appendix E. Based on these beneficiaries potential funding sources identified 
include: 

 Community Infrastructure Levy 

 Benefitting local businesses 

 Council Tax 

 Local Enterprise Partnerships 

There are a large number of commercial properties at risk within the town. Further consultation 
would be required to identify potential contributions.  
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1.7.2 Key delivery risks (economic, social and environmental) 

 

Table 1-7 Risks and mitigation  

Risk Key Mitigation 

Estimate of benefits highly uncertain 
Undertake more detailed benefit analysis 
at OBC stage 

Estimate of costs highly uncertain 
Undertake more detailed benefit analysis 
at OBC stage 

Risk of pollution incidents and disruption to area 
during construction 

Ensure a detailed site action plan is in 
place prior to any site work commencing 

PLP may not be effective for the properties due 
to flood depths, durations and presence of 
groundwater risk. 

Detailed modelling to use flood depth grids 
to assess total depth to properties 

The height of the flood defences have been 
estimated and may be insufficient  for  the SoP 
required for an event of the magnitude of Boxing 
Day 2015 

Undertake further modelling to establish 
the correct level of the defences for such 
an event. 

 

1.8 Project scoring 

The data used in this assessment has been subjected to a RAG assessment. A green score is well 
defined, not likely to be an issue; amber score, needs development, but is manageable; red score 
is poorly defined, lots of uncertainty, likely to cause significant problems. The RAG assessment 
gives a three figure score with the first number being the number of reds, the second and third 
numbers are the number of amber and green respectively. The results are shown below: 

 

 A – Problem Definition: The fluvial flood risk is well understood but more accurate 
information are needed about the flood path and the ground water – AMBER 

 

 B – Economic Case: The benefits assessment has been based on moving properties from 
flood risk bands and weighted average annual damages – GREEN 

 

 C – Funding: All The options require external funding. Work will be needed to obtain funding 
but there are opportunities – AMBER 

 

 D – Engineering case: Solutions taken to outline design are common defence options, no 
particular issues are expected – GREEN 

 

 E – Permissions & Consents: Solution are unlikely to require unusual permissions or 
consents, but permission for third party properties is required  – AMBER 

 

 F – Environmental sensitivities: An Environmental check list has been completed and the 
options will not have any impact on any nearby sites of interest – GREEN 

 

 G – Opportunities: Some potential opportunities for partnership working but minimal 
environment opportunities – AMBER 
 

 

Model. 
A 

Econ 
B 

Funding 
C 

Eng. 
D 

Permission 
E 

Env. 
F 

RAG Opps. 
G 

2 3 2 1  2  1 132 2 
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1.9 Further work requirements 

If the project is taken forward for further appraisal it is recommended that the following work is 
undertaken to confirm the feasibility of the options: 

 Hydraulic modelling is undertaken to predict likely flood depths, duration and overland 
flow pathways. The modelling will also be used to inform crest heights required for 
different standard of protection levels. 

 Effect on groundwater and surface water run-off of the options. 

 Update the PV benefits and re-assess the partnership Funding score. 

 Consultation with landowners.  

 

 

1.10 Conclusions and Recommendation 

The aim of this initial assessment is to give an overview of the principal flood risk issues affecting 
the study area, propose suitable flood risk reduction options and assess their viability. The resultant 
outcome is an analysis of a number of agreed options and further recommendations to carry 
forward those which exceed the required benefit versus cost threshold to OBC stage. 

The economic assessment developed at this stage includes a high margin of uncertainty. The 
modelled flood outlines used to evaluate the benefits are outdated, and need to be calibrated using 
recent flood events. For a more detailed assessment the main requirement will be detailed hydraulic 
modelling to understand the current standard of protection provided to the properties, clarify the 
flow pathways and better quantify the Do Nothing damages and the benefits the potential options 
would provide. 

Further analysis is recommended to evaluate the risk of groundwater and surface water flooding; 
if there is significant risk present this will reduce the effectiveness of the proposed options. Option 
1, which considers PLP for each property at risk is the only Do Something option to score an 
incremental BCR > 1, and is therefore recommended to be carried forward to OBC stage. 

Based on the final Partnership Funding scores none of the Do Something options score high 
enough to avoid the need for external funding. Option 1 gains the highest BCR of 2.35; however, 
there are considerable uncertainties in the assessed costs and benefits and the preferred option 
may change with further appraisal. Furthermore, considering the number of properties at risk and 
the frequency of flooding in the study area, it is also recommended to consider Option 2 for further 
appraisal as this option may demonstrate greater benefits when informed by detailed hydraulic 
modelling.  

The study area is already within a Flood Warning and Flood Alert area but flood action plan could 
be improved to reduce reaction times; this would work well with Option 1, ensuring enough time is 
given to property owners to erect the defences.  

 

A large scale Flood storage area (FSA) within the system is considered in the long list of options. 
This is a large-scale scheme that will have significant impacts beyond the study area and is 
considered to be outside the scope of this initial assessment. It is recommended that this is 
considered in future work to provide protection to Ash Grove and Wagon Lane. Under this option, 
one of the possible FSA locations is near the Bingley Bypass, this area is made up landfill/ waste 
material, and so will involve the movement of potentially contaminated material, which will bring in 
significant additional cost and environmental risk. 
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